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Introduction 

Audience 

The audience for this manual includes station engineers or technicians working for 

content creators or third-party providers.  

Note Media distributors are required to actively encode using the Nielsen encoding methodology per 

their service agreements with Nielsen. 

Customer Support 

Nielsen Support Location 

Nielsen Encoder Support 800-537-4872 option 2 

Encoders@nielsen.com 

Nielsen Engineering Client Portal https://engineeringportal.nielsen.com 

Nielsen Global Technology Center Nielsen 

501 Brooker Creek Blvd 

Oldsmar, FL 34677 

www.nielsen.com 

Conventions Used in this Document 

The following items appear in this document:  

Note This paragraph flags a key point, indicates a tip, or identifies an alternate way of performing a task. 

Important This paragraph emphasizes one or more actions that must be followed to avoid a catastrophic 

failure. 

Related Documents 

CableLabs Asset Distribution Interface Specification Version 1.1 

CableLabs VOD Content Encoding Profiles Specification: specification for encoding AC-3 

files 

CableLabs VOD Metadata Specification Version 1.1: specification for providing metadata 

for AC-3 files 

mailto:Encoders@nielsen.com
https://engineeringportal.nielsen.com/
http://www.nielsen.com/
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Nielsen Encoding Installation and Configuration Policy 

VOD Encoder Installation Quick Start: procedures for installing the encoder applications 

products 

Encoding and Transferring Metadata 

VOD Content Encoding 

The VOD Content Encoder (the Encoder) watermarks audio content of a VOD (Video on 

Demand) asset. Essentially, the Encoder reads input from an audio file, generates an 

encoded file, and sends metadata to the Nielsen Collection Facility (CF): 

Note The Encoder refers to the package that includes the VOD Content Encoder application, WRR 

Installer application, and WRR. 

Metering equipment in Nielsen family members’ homes captures these audio codes (also 

called watermarks) from television viewing and sends them to the CF, where back-end 

systems use them to credit viewing. 

The Encoder watermarks audio in transport streams that are in MPEG-2 format and have 

one of the following extensions: 

 *.mpg 

 *.m2t 

 *.trp 

 *.ts 

Types of Watermarks 

The Encoder has the ability to insert three types of audio codes: Nielsen Audio Encoding 

System II (NAES II), Nielsen Watermarks (NW), and CBET (Critical Band Encoding 

Technology) Watermarks.  

 Nielsen watermarks (NAES II and NW) consist of a unique SID (source identifier) and 

a number referred to as a TIC (time-in-content). 

 NAES II is the second-generation method of inserting a SID and time stamp into 

a TV signal 

 NW is a newer method of audio encoding that places the SID and time stamp 

into a lower-frequency portion of the active program than does NAES II 

technology. Its lower-frequency position enables NW to be more robust and 

much less likely to be “compressed out” of the program audio by TV distribution. 

 CBET is a watermark that consists of a unique CSID (CBET source identifier).  

https://engineeringportal.nielsen.com/w/downloads/tv/Encoding/Encoding_Installation_and_Configuration_Policy_Rev_G.pdf


 VOD Content Encoder User Manual 

 

 

Release 6.0 Revision J 8 Nielsen Confidential 

 BOC is a watermark that is designed for content identification of both VOD (video-on-

demand) and commercials. It is an eight-digit hexadecimal expression. 

If the CSID is associated with the SID, both the CSID and BOC (Billions of Codes) 

watermarks are inserted.  

ZIP Metadata File 

As individual VOD files are watermarked, the Encoder generates a zipped file, referred to 

as ZIP Metadata, The encoder transmits ZIP Metadata files to the Nielsen CF. The file 

name for ZIP Metadata is in the format <SID>_<TIC>_<StartingTimeStamp>.zip. (For 

information on how to transfer the files, see “File Transfer Options” on page 13.)  

ZIP Metadata contains the following files: 

 Feed-point metadata xml file: contains information that Nielsen uses to uniquely 

identify the VOD asset including the SID, a range of TICs, asset ID, and information 

about the VOD content. The format for the file name is <SID>_<TIC>_nmr.xml. Table 

1 shows the contents of the feedpoint metadata XML file: 

Table 1: Feed-Point Metadata File Contents 

Field Description Comment 

ADIFileName Name of the CableLabs file (if 

any) that is transferred to the CF 

with the feed-point metadata file 

Optional 

Note ADI files are created by 

applications not under the 

control of Nielsen, therefore, 

we cannot guarantee that the 

ADI file is well-formed. 

ProviderId ID of the content provider May be derived from a Provider ID 

field in the CableLabs file 

Provider Name of the content provider May be derived from a Provider 

field in the CableLabs file 

AssetId ID of the encoded content 

Max supported length is 20 chars 

May be derived from an Asset ID 

field in the CableLabs file 

AssetName Name of the encoded content 

Max supported length is 50 chars 

May be derived from an Asset 

Name field in the CableLabs file 

EpisodeId Unique identifier given to each 

episode of a given series 

Max supported length is 20 chars 

String characters, such as 

Episode #45 (may be derived from 

an Asset Name field in the 

CableLabs file) 

OriginatorId Unique Nielsen number to link 

back to the content provider. 
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Field Description Comment 

WatermarkTime The actual system time that the 

watermarking process started, 

expressed as UTC (Coordinated 

Universal Time) 

 

SID Value of SID that was inserted into 

this asset 

 

CSID Value of CSID that was inserted 

into this asset 

When WRR is not configured with 

CSID and BOC along with SID 

then only SID insertion is done in 

asset and values for CBET and 

BOC are set to zero in metadata. 

CBET Layer Value of CBET layer, which is 

either 2 (network) or 5 (local TV) 

BOC Value of BOC 

BOC Remaining Number of BOCs available on 

WRR for encoding 

StartingTIC Value of first TIC presented to the 

watermarking algorithm for 

insertion into the asset. 

First TIC (may be significantly 

offset from the AllocatedStartTIC, 

depending upon the location in the 

stream of the first frame of audio) 

EndingTIC Value of the last TIC that the 

encoder presented to the 

watermarking algorithm for 

insertion into the asset 

Last TIC (may be significantly less 

than the value of the 

AllocatedEndTIC, depending upon 

the location in the stream of the 

last frame of audio) 

AllocatedStartTIC Value of the first TIC reserved: 

and the first TIC presented to the 

watermarking algorithm for 

insertion into the asset 

 

AllocatedEndTIC Value of the last TIC reserved for 

this asset 

 

HDContent True if and only if content is high 

definition. 

Not currently used (undefined) 

FileSizeBytes Size of the encoded file in bytes  

FileSizeSeconds Approximate duration (in seconds) 

of the encoded file 

 

 

 CableLabs ADI.xml file (optional): may be attached for VOD content compliant with 

the CableLabs standard (AC-3 audio). The ADI.xml file, which the provider supplies 

and is distributed to cable head-ends, must conform to CableLabs® Asset Distribution 

Interface Specification Version 1.1. 

 Decoder and signature log files: 

 Decoder logs are generated for NAES-II and NW watermarks and CBET 

Watermarks.  

https://community.cablelabs.com/wiki/plugins/servlet/cablelabs/alfresco/download?id=6e8bf0b2-0356-4464-b4e2-72e9c60dc5a7
https://community.cablelabs.com/wiki/plugins/servlet/cablelabs/alfresco/download?id=6e8bf0b2-0356-4464-b4e2-72e9c60dc5a7
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 Signature logs are generated for PAS, DNA, NDASH, and UNITAM signature 

algorithms. 

Decoding and signature generation is automatically done during VOD content 

encoding. 

VOD Content Encoder Components 

This section describes the components that make up the VOD Content Encoder: 

 VOD Content Encoder software 

 SID/TIC Server 

 WRR 

 File Transfer Manager (optional) 

 ServicesMonitorTool 

VOD Content Encoder Software 

This application encodes and decodes. It also can send the ZIP Metadata file described 

above directly or indirectly to the CF. The application can be run from a graphical user 

interface, a command-line tool, (ContentCodeCmd), or a File Trigger Service. See “Install 

VOD Content Encoder Application” on page 17. 

SID/TIC Server (The Server) 

The SID/TIC Server is an application that maintains mirror databases on the Server host 

computer. Before responding to any Encoder request and, for almost any transaction, the 

Server first verifies all databases are present and identical. The Server runs as a service 

that automatically starts when the computer hosting it boots. A VOD Discovery Service 

“listens” on a port for “discovery” requests from the Encoder.  

The SID/TIC Server allows only one connection at a time, completely processing each 

request before servicing the next. Since the processing of a request requires only a 

fraction of a second, the serialization of processing should not be a problem, even in the 

busiest encoding facility. If more than one Server is configured, each Server allocates a 

different range of SID/TICs. See “Install SID/TIC Server” on page 18. 

Workflows that configures VOD to discover SID/TIC server on network needs VOD 

Content Encoder and SID/TIC server to be installed on the same network subnet. 

Workflows that include cloud interactions do not support VOD Discovery Service. Contact 

Nielsen Encoder Support for a Discovery Service workaround. See page 6 for the contact 

information. 

WRR (Watermark Resource Record) 

The WRR is an encrypted file that Nielsen preconfigures with client-specific SID/TIC, 

CBET, and BOC information. The WRR can be installed with the WRR installer during or 
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after installation of the SID/TIC Server software. The SID/TIC Server needs the WRR for 

handling Encoder requests. The WRR contains the following information:  

 WRR Header 

 Serial Number: number that uniquely identifies the WRR provided to the client  

 WRR state: indicates the current WRR state. The WRR can be in one of the following 

states: 

 ReadyToInstall: indicates the WRR can be used for a new WRR installation or 

upgrade of an existing WRR 

 Active: indicates the WRR is installed and will be used for TIC allocation 

 InActive: indicates the WRR is installed and cannot be used for TIC allocation 

 ManualBackupCopy: indicates the WRR was created when Deactivate WRR was 

done on the WRR Installer. A WRR in this state cannot be used for installation, 

upgrade, or TIC allocation. 

 AutomaticBackupCopy: indicates the SID/TIC Server created the WRR on every 

successful encoding session. A WRR in this state cannot be used for installation, 

upgrade, or TIC allocation. 

 WRR Creation Date: identifies date when Nielsen Encoder Support created the WRR 

 WRR Modification Date: identifies WRR modification date for the last successful 

encoding session 

 Redundancy: indicates the WRR redundancy status 

 NoRedundancy: indicates the WRR does not support redundancy 

 PrimaryWRR: indicates the WRR supports redundancy and the WRR is the 

Primary WRR of the redundant WRR system 

 RedundantWRR: indicates the WRR supports redundancy and the WRR is the 

redundant WRR of the redundant WRR system 

 WRR Installation Validity: indicates the last date for the WRR to be used for 

installation or upgrade. After the WRR expires, contact Nielsen Encoder Support to 

get a new WRR. 

 NoOfRecords: number of SID/TIC records in the WRR 

See “Install WRR” on page 48. 

File Transfer Manager (Optional) 

Important The VOD Content Encoder software includes the File Transfer Manager application. Only install 

the File Transfer Manager as a separate installation on a computer that does not have the VOD 

Content Encoder software on it. 

The VOD Content Encoder software includes the capability to directly transfer files to the 

Nielsen CF. You can, however, install a separate application, File Transfer Manager, onto 

a second computer. You would then configure the Encoder to use its transfer function to 
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send the ZIP Metadata files to the second computer, which would use File Transfer 

Manager to send those files to the Nielsen CF.  

For batch file encoding, you must install File Transfer Manager. See “Install File Transfer 

Manager” on page 20 and “Configure the File Transfer Manager” on page 25. 

ServicesMonitorTool 

The ServicesMonitor Tool is an application that is automatically installed with the VOD 

Content Encoder software, standalone File Transfer Manager software, and SID/TIC 

Server. The ServicesMonitorTool runs in the background and is accessible from the 

taskbar. The application has a graphical user interface (GUI) that enables you to 

configure the application to monitor services and restart the services when they are not 

running. By default, the GUI displays an alert when metadata files fail to transfer to the 

CF. Although you can configure the transfer error popup to not appear, doing so is not 

recommended. See “Configure the ServicesMonitorTool” on page 42. 
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File Transfer Options 

To receive credited viewing, the ZIP Metadata file containing the feed-point metadata file 

that corresponds to the encoded files must be sent to the CF. You can use various 

options to send the metadata file to the CF. See also the workflows in “Appendix A: 

Workflows” on page 70. 

In addition to these transfer flows, there are different configurations that you can use: 

 Directly transfer the file to the CF: the File Transfer Service uses secure FTP to 

directly send files from the Encoder to the CF. 

 Transfer ZIP Metadata files to a local server: the Encoder uses the FTP function that 

is included in the VOD Encoder application or a third-party FTP application to transfer 

ZIP Metadata files to a transfer server and then the Nielsen File Transfer Service 

sends the files to the CF 

In addition to these transfer flows, you use these different configurations: 

 Use the File Transfer Service to automatically send the ZIP Metadata file 

Overview of Methods of Transferring Metadata 

There are a few different methods for transferring ZIP Metadata files to the CF: 

Note For details, see the workflows in “Appendix A: Workflows” on page 70. 

 VOD Content Encoder application—if you are directly transferring files from the 

computer that does the encoding to the Nielsen CF, you configure the File Transfer 

Manager from within the VOD Content Encoder application itself. See “Configure the 

VOD Content Encoder Application” on page 22. 

 File Transfer Manager application: if the File Transfer Manager is installed on a 

different computer from the Encoder application, the Encoder uses the FTP function 

that is included in the VOD Encoder software to transfer the ZIP Metadata files to a 

transfer server. The file transfer manager on the transfer server transfers the ZIP 

Metadata file to the Nielsen CF. 

Important Install or enable only one FTP application on a computer. 

 The File Transfer Service monitors the metadata folder and periodically transfers all 

the ZIP metadata present in the folder to the CF. See Figure 7 on page 23. 
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File Trigger Service Overview 

The File Trigger Service (the Trigger Service) performs content-based encoding 

according to parameters defined in a standard XML file. For the format of the file, see 

“Appendix B: Contents of XML Files” on page 75. 

1. The Trigger Service reads the encoder configuration. For details on setting these 

parameters, see Figure 7 on page 23. 

2. The Trigger Service extracts the following settings entered into the 

FileTriggerManager window. See Figure 10 on page 27. 

 XML File Path—the path to the EncoderParamFolder, which is the extracted path 

name and is sometimes referred to as the encoder parameter folder 

 Scratch Folder setting, was used in the optional tar processing (TAR file 

processing is no longer supported. The presence of this setting is only for 

configuration purposes) 

3. From the encoder configuration file, the Trigger Service extracts the SID/TIC Server 

IP address and all other configuration settings directly related to content-based 

encoding. 

4. The Trigger Service repeatedly checks EncodeParamFolder, searching for all files 

that have the extension “xml.” 

5. The Trigger Service makes a list of those xml files and processes the xml files, one at 

a time, as follows: 

a. Opens the xml file 

b. Reads the file 

c. Validates all encoder parameter settings in the file 

d. Closes the file. See Table 17 for a complete listing of settings that may be 

extracted from the xml file. 

e. The Trigger Service extracts settings from the xml file and uses them as the 

parameters to encode the specified video source file. The Trigger Service 

uses the same encoding process (including interacting with the SID/TIC 

Server, creating and naming metadata files, and logging status and errors) 

that the VOD Content Encoder application uses. 

f. When the source file has been successfully encoded, the Trigger Service 

deletes the corresponding xml file from the drive. 

6. When all files in the xml list are fully encoded, the Trigger Service repeats steps 4 

and 5. 

7. The Trigger Service runs until it is manually stopped. 
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Use the File Trigger Service with Tar Files 

Important TAR file processing is no longer supported. Please contact Nielsen 

Encoder Support for more information 
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Install Software Applications 

Requirements 

Important To permit the encoding software to run without interference, disable antivirus and firewall 

programs. If this is not possible, add the *.exe files to the “exclude” or “trust” list in your antivirus 

software. For details, see “Encoder Services Are Not Running or Repeatedly Fail” on page 54. 

Environment 

 One or more computers, depending on workflow (see Appendix A: Workflows on 

page 70) 

 Dedicate all computers used to perform VOD Content Encoding solely to 

encoding:  

Important To permit the encoding software to run without interference, disable antivirus and firewall 

programs. If this is not possible, add the *.exe files to the “exclude” or “trust” list in your antivirus 

software. For details, see “Encoder Services Are Not Running or Repeatedly Fail” on page 54. 

 Do not install software that does not relate to encoding such as email, word 

processing, spreadsheets, etc. 

 Platforms: one of the following Microsoft operating systems: 

 Windows 10 64-bit 

 Windows Server 2008, 64-bit 

 Windows Server 2012, 64-bit 

 Windows Server 2016, 64-bit 

 Windows Server 2019, 64-bit 

 Preferred screen resolution of 1024 x 768 pixels, although 800 x 600 is acceptable 

 IP connectivity 

VOD Content Encoding Package 

The installation package for the VOD Content Encoder includes the following items: 

 VOD Content Encoding application 

 File Transfer Manager application (optional) 

 1 or 2 WRR (watermark resource record) files with optional SID or redundancy status 

indicated in the file name 
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 SID/TIC Server and WRR Installer application 

Note In configurations where having a single point of failure is unacceptable, you can install two SID/TIC 

Servers in the network. For such setups, Nielsen provides a WRR for each active SID/TIC Server. 

Both WRRs are configured with the same SIDs; however, for each SID in the list, each Server 

manages a unique set of TICs.  

Supported Formats for Digital Assets 

Important All digital assets processed by the VOD Content Encoder must be clean: they cannot contain any 

Nielsen watermarks. 

 MPEG-2 transport stream files with audio stream in AC3 format conforming to 

CableLabs VOD Content Specification 1.1 MD-SP-VOD-CEPT-I01-040107 

 48 kHz AC3 files: 

Note The VOD Content Encoder does not support encoding of MPEG files with both AC3 and PCM in 

the same file. 

Install VOD Content Encoder Application 

As you perform the installation procedures in this section, keep in mind that we want two 

results from the process: encoded files to be provided for viewing and transfer of 

metadata files to the Nielsen CF to enable crediting of viewing.  

1. If you have not already done so, extract the VOD Installer zip file. 

2. Browse to the VOD Encoder folder and double-click autorun.exe. The Nielsen VOD 

Content Encoder installation window appears. 

 

Figure 1: Installation Window 

3. Click Install VOD Content Encoder. 
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4. If prompted, follow the prompt to install Microsoft Visual C++ Redistributable 

Package. If you get error that higher version of C++ Redistributable already installed 

than select yes to continue with installation. 

5. If prompted, follow the prompt to install Microsoft .Net Framework 

6. Click Next. 

7. Enter your user name and company name. 

8. Click Next. 

9. Click Install. A message appears regarding changes to your firewall software. See 

Figure 2. 

 

Figure 2: Firewall Message 

10. Assuming you have cleared this installation with your IT administrator, click Yes. A 

command line window appears and shows progress then closes and a message 

appears indicating the installation is complete. 

11. On the InstallShield Wizard, click Finish. 

Note If the SID/TIC Server will not be installed on the VOD Content Encoder host machine, use the 

procedure, “Configure the ServicesMonitorTool,” on page 42 to disable monitoring of the SID/TIC 

Service and the Discovery Service. 

Install SID/TIC Server 

Important A computer that hosts a SID/TIC Server can have only one WRR installed at a time. A network, 

however, can have more than one SID/TIC Server running on it.  

Note Workflows that configures VOD to discover SID/TIC server on network needs VOD Content 

Encoder and SID/TIC server to be installed on the same network subnet. 

1. Browse to the VOD Encoder folder. 

2. Double-click autorun.exe in VOD Encoder folder. The Nielsen VOD Content Encoder 

installation window appears. See Figure 1. 

3. Click Install SID/TIC Server. 

4. Click Next. 

5. If prompted, follow the install Microsoft Visual C++ Redistributable Package. . If you 

get error that higher version of C++ Redistributable already installed than select yes 

to continue with installation 
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6. If prompted, follow the prompt to install Microsoft .Net Framework 

7. Enter your user name and company name. 

8. Click Next. 

9. Click Install. 

10. Click OK. The WRR Installer window appears. 

11. On the WRR Installer application window, click Install WRR. See Figure 3 and Figure 

4. 

 

Figure 3: WRR Installer Application – Install WRR 

12. To load the WRR file provided by Nielsen Encoder Support, on the Install WRR 

window, click Load WRR. 

 

Figure 4: Install WRR Window – Load and Install WRR 
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13. Browse to the location of the WRR that Encoder Support sent to you and click Open.  

Note If a WRR is not available, you can use the WRR Installer Tool to install it later. For now, follow the 

steps on 47 to generate a UniqueKey then send the file to Encoder Support to get a new WRR. For 

now, go to step 16 to continue SID/TIC Server installation. 

14. Click Install. 

15. Do one of the following: 

 If the installation was successful, the Install WRR dialog box closes. Go to 

step 16. 

 If an error occurred, contact Nielsen Encoder Support. 

16. Close the WRR installer. 

17. Assuming you have cleared this installation with your IT administrator, click Yes. A 

command line window appears and shows progress then closes, followed by an 

indication that the installation is complete. 

18. On the InstallShield Wizard, click Finish. 

19. Click Exit. 

Note If the SID/TIC Server will not be installed on the VOD Content Encoder host machine, use the 

VODServicesMonitor Tool to disable monitoring of the File Transfer Server and File Trigger 

Service. Follow the procedure, “Configure the ServicesMonitorTool,” on page 52 to disable 

monitoring of the SID/TIC Service and the Discovery Service. 

Install File Transfer Manager 

Because the File Transfer Manger is incorporated into the VOD Content Encoder 

application, the installation software stops you from installing the FTM software on the 

same computer as the encoder application. 

Important If a computer already has a third party FTP program installed, do not install the File Transfer 

Manager application on it. If, however, you want to do batch processing, you must disable the FTP 

program and install the File Transfer Manager. 

1. Browse to VOD Encoder folder and double-click autorun.exe. The Nielsen VOD 

Content Encoder installation window appears. See Figure 1. 

2. Click Install File Transfer Manager.  

3. Click Next. 

4. If prompted, follow the prompt to install Microsoft Visual C++ Redistributable 

Package. 

5. If prompted, follow the prompt to install Microsoft .Net Framework. 

6. Enter your user name and company name. 

7. Click Next. 
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8. Click Install. When the install completes, a message appears regarding the firewall. 

9. Assuming you have cleared this installation with your IT administrator, click Yes. A 

command line window appears and shows progress then closes, followed by an 

indication that the installation is complete. 

10. On the InstallShield Wizard, click Finish. 

Note If the SID/TIC Server will not be installed on the VOD Content Encoder host machine and SID/TIC 

Server machine, use the VOD ServicesMonitor Tool to disable monitoring of the Discovery Service, 

File Trigger Service, and SID/TIC server. Follow the procedure, “Configure the 

ServicesMonitorTool” on page 42 to disable monitoring of the SID/TIC Service and the Discovery 

Service. 
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Configure Encoder Software Applications 

This section covers configuration of the following: 

 VOD Content Encoder application 

 (Optional) File Transfer Manager application 

 (Optional) File Trigger Service 

Configure the VOD Content Encoder Application 

Important Install SID/TIC server software and WRR database before configuring the VOD Content Encoder 

application ,see “Install SID/TIC server” on pg 20.  

Note For instructions on configuring and using the ContentCodeCmd tool instead of the GUI (graphical 

user interface), see “Use ContentCodeCmd to Encode” on page 34. 

Note On changing new SID/TIC Server address (Server with different SID’s) in Encoder Configuration 

window, restart the Content Encoder GUI app to load and display the new SID/TIC records in 

Profile Editor. Delete and create new profiles in profile editor, if the new SID/TIC Server is 

configured with different SID then previous SID/TIC Server. 

1. Restart your antivirus software. 

2. In your antivirus software, add the following to the list of “exclude” or “trusted” files: 

 SIDTicService.exe 

 STSDiscovery.exe 

 VODFileTrigger.exe 

 VODFTMService.exe 

3. From the list of programs in Windows, select VOD Content Encoder. One of the 

following occurs: 

 

Figure 5: VOD Content Encoder Command 
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 If the application can communicate with its SID/TIC Server and there is a valid 

profile, the VOD Content Encoder application window in Figure 6 appears. Go to 

step 9. 

 

Figure 6: VOD Content Encoder Application GUI Window 

 If the application cannot communicate with its SID/TIC Server, It displays error 

popup after few seconds. Select yes to edit configuration and Encoder 

Configuration (System Setup) window appear as shown in Figure 7.  

 Resolve the SID/TIC communication issue, save configuration and Go to step 4. 

 

Figure 7: Encoder Configuration (System Setup) Window 
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 If the application does not find a valid profile file it display popup to update/create 

profile config and on pressing OK button, the Profile Editor window (Figure 8) 

appears. Go to step 5. 

4. On the menu bar, select Configure > Profile Setup. 

5. On the Profile Editor window, enter a name for the profile. 

Note Once you assign a Profile Name, you cannot change it. To rename a profile, delete the profile and 

add a new one. If you received a new WRR with a different SID, delete the existing profile and 

create a new profile with the new SID on the WRR. 

 

Figure 8: Profile Editor Window 

6. Select the path for each item in Table 2. 

Table 2: Profile Window Settings 

Path Description 

Video Source Path Files to be encoded 

Encoded File Path Saved encoded files 

ADI File Path (If applicable) ADI-compliant files to 

be transferred 

 

7. Select a SID/Distribution Source. 

8. Click Apply. 

9. On the menu bar in the Nielsen VOD Content Encoder window, click Configure > 

System Setup. The Encoder Configuration window appears. See the workflows in 

“Appendix A: Workflows” on page 70. 
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 (Optional) Configure the File Transfer Manager Application 

If you install the VOD Content Encoder application and File Transfer Manager on 

separate machines as in Workflow 3 and Workflow 5, you must configure the File 

Transfer Manager application. See “Appendix A: Workflows” on page 70. 

1. From the list of programs in Windows, select File Transfer Manager. 

2. Select the Transfer Mode and do one of the following: 

 If you select Transfer to Data Collection Facility (direct transfer to the Nielsen 

CF), the contents of File Transfer Configuration window is automatically filled 

with data in the configuration file provided by Nielsen. Go to step 3 and 

update Metadata Folder and Archive Folder to match them with your 

environment. 

 If you select Transfer to Local Server (indirect transfer to CF), go to step 3.  

 

Figure 9: Transfer Configuration Window 

3. Complete the fields shown in Table 3. 

Table 3: Feed Point Transfer Parameters 

Field Description 

Metadata Folder The local location of the metadata files to be transferred 

Default is C:\ Nielsen\metadata. 

Archive Folder The local location of the folder where metadata files that 

already transferred are stored 

Default is C:\ Nielsen\arch_metadata 
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Field Description 

Server Address Supplied by Nielsen 

Server Login Supplied by Nielsen 

Server Password Supplied by Nielsen 

Remote Folder The folder on your transfer server where the metadata 

files are stored before transfer to the CF. Supplied by 

Nielsen 

 

4. Click Save and close the window. Files are sent on the set interval. 
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(Optional) Configure the File Trigger Service 

The VOD File Trigger Manager application is automatically installed during the VOD 

Content Encoder application installation. This service is optional for you to use to 

manually or automatically trigger VOD content encoding. 

The File Trigger Service monitors a “watch” folder that contains an XML trigger file that 

initiates encoding with the content identified in the file. 

Configure the Trigger Service to Run Manually 

1. From the Windows Start menu, select Nielsen > VOD File Trigger Manager. 

2. On the File Trigger Manager window, browse to the XML File Path to the trigger file 

watch folder. See Figure 10. 

Note The XML File Path is the path to the EncoderParamFolder, which is the extracted path name and is 

sometimes referred to as the encoder parameter folder. “Appendix B: Contents of XML Files” on 

page 75 shows examples of the XML files. Scratch Folder setting is used when using the tar-file 

processing option. Tar processing is no longer supported. Scratch Folder setting is only for 

configuration purpose. 

3. Browse to the Scratch folder or another empty, temp folder.  

4. Click Save Config. 

 

Figure 10: File Trigger Manager Window 
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Configuring the File Trigger Service to Run Automatically 

1. To start automatically after reboot, open the Control Panel. 

2. Select Administrative Tools > Services. 

 

Figure 11: Administrative Tools > Services 

3. Right-click NIELSEN VOD File Trigger Service and select Properties from the menu. 

 

Figure 12: File Trigger Service in Services 
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4. In Startup type on the Properties window, select Automatic and click OK. 

 

Figure 13: File Trigger Service Properties 
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Encode 

You can encode using a graphical user interface (GUI) or a command line tool 

(ContentCodeCmd). 

Use GUI to Encode 

Important All digital assets that the VOD Content Encoder processes must be clean: they cannot contain any 

Nielsen watermarks. 

Note Encoding asset with multiple audio streams may make GUI unresponsive during encoding session 

due to system processing power. 

1. From the Start menu, start the VOD Content Encoder application. 

2. On the Configure menu, select Profile Setup. 

3. In the Profile List, select the profile you want and click Apply. 

 

Figure 14: Profile Editor 
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4. On the Source Video tab, select an MPEG-2 file to be encoded.  

 

Figure 15: Main Window 

5. Click Encode. The Feed Point Information window appears (Figure 16). 

 

Figure 16: Feed-Point Information Window 

6. (Optional) If available, browse to select the corresponding ADI file, which must be 

compliant with the CableLabs specification. 
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7. Enter the following: 

 Asset ID: uniquely identifies the asset that is being encoded. If a CableLabs® 

ADI file is identified for the asset, then this field is populated with the Asset ID 

from the ADI file. ( Max supported length for Asset ID is 20 characters ) 

 Asset Name: descriptive name of the asset being encoded. ( Max supported 

length for Asset Name is 50 characters ) 

 Episode ID: (optional) uniquely identifies the episode of the asset( Max 

supported length for Episode ID is 20 characters ) 

Note The Dist Src ID and Name, Nielsen SID, and Duration are populated from the Encoder 

configuration and are read-only. 

8. Click OK. If the encoding session completes successfully a “Watermarking 

succeeded” message appears. “Finished processing Status” shows a return code 

of 0. See Figure 17. 

 

Figure 17: Watermarking Successful Message 

9. Click OK. 

10. Click Close. The main window also indicates the success of the encoding process.  
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Figure 18: Watermarking Success Indicator 
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Use ContentCodeCmd to Encode 

The command-line version of the VOD Content Encoder is called ContentCodeCmd. 

ContentCodeCmd enables you to automate encoding and decoding. 

Note You can also automate file transfer. For more information, see “Transfer Metadata Files to the 

Nielsen CF” on page 39. 

ContentCodeCmd Arguments 

The VOD Encoder package includes a batch file, InsertContentCodes.bat, which includes 

a call to ContentCodeCmd.exe. You may edit the command line arguments in this .bat file 

to meet your requirements, and then execute the .bat file to conduct a single 

watermarking session. 

Table 4: Encoding Command Line Arguments 

Argument Description 

Sid Nielsen source identifier 

Input Full path name of the file containing the MPEG-2 transport stream to be 

watermarked 

Output Full path name of the generated watermarked file 

Assetid String for content to be encoded, ( Max supported length for assetid is 20 

characters ) 

asset name Descriptive name for content to be encoded; passed to the CF in the 

feed-point metadata file ( Max supported length for asset name is 50 

characters ) 

Episode String for the episode to be encoded (optional) ( Max supported length 

for episode is 20 characters ) 

Adifile Full path name for CableLabs-compliant file to be transferred to the CF 

discovermask Broadcast subnet address that defines the set of computers that the 

application searches in the process of “discovering” an active SID/TIC 

Server. The default value is 255.255.255.255. Depending upon your 

network configuration, you may wish to further restrict the broadcast 

address to a specific subnet. For example, if your subnet is 10.6.1.nnn, 

the UDP broadcast could be modified using the parameter –

discovermask 10.6.1.255. 

discoverport Number of the User Datagram Protocol port on which the Discovery 

Server listens for UDP broadcasts. The default value is 6543. Only 

modify this port if it conflicts with some other service on your network. 

Server Fixed network address of the host where the SID/TIC Server is running.  

If your SID/TIC Server site uses dynamic address assignment (DHCP), 

you must use the discovery feature (do not set the server IP address). 
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ContentCodeCmd Format 

When using ContentCodeCmd to encode, use this format to set the parameters 

described above: 

Note Launch the command line application in Administrator Mode to view the encoding status 

messages. 

ContentCodeCmd   

-sid <SID>  

--input <input file>  

-output <output file> 

-assetid <asset ID> 

-asset name <asset name> 

[-episode <episode ID>] 

[-adifile <ADI file name>] 

[-discovermask <UDP broadcast address>] 

[-discoverport <UDP port number>] 

[-server <Primary SID/TIC server address>] 

[-server2 <Redundant SID/TIC server address>] 

Encoding Example 1 

The code in this example encodes the file, “C:\MPEGFILES\Unprocessed\test.mpg” with 

a Nielsen SID of 9001 and stores the encoded file in 

“C:\MPEGFILES\Processed\test.mpg,” where the sole SID/TIC Server on the network is 

located on a host computer with the IP address of 10.45.212.100. 

1. Open the command prompt in administrator mode to view the encoding status. 

2. Enter the following at the command prompt: 

ContentCodeCmd -sid 9001 -input "C:\MPEGFILES\Unprocessed\test.mpg"-output 

C:\MPEGFILES\Processed\test.mpg --assetid "54321" -assetname 

"InterestingClip" –episode “Episode 1” –server “10.45.212.100” 

Note Because the server is automatically discovered, the server argument is optional. 

Note If the CSID is associated with the SID is in the WRR, CSID information is not needed as it is 

automatically retrieved from the SID/TIC Server. 

server2 Fixed network address of the host where redundant SID/TIC Server is 

running. Server2 input makes the encoder alternate between server and 

server2 for each encoding session.  

If your SID/TIC redundant site uses DHCP, do not set server2. When the 

server2 option is used, do not specify either server or server2 as a 

broadcast subnet address. 
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Encoding Example 2 

Note In Example 2 and Example 3, refer to Workflow 4 in Appendix A: Workflows on page 69. 

In this example, the Encoder encodes the same file, with the same output file name, 

where there are two active SID/TIC Servers on the system. 

ContentCodeCmd -sid 9001 -input "C:\MPEGFILES\Unprocessed\test.mpg"-output 

C:\MPEGFILES\Processed\test.mpg -server "127.0.0.1" -assetid "54321" -

assetname "InterestingClip" –discovermask “255.255.255.255” 

Encoding Example 3 

In this example, the Encoder encodes the same file with the same output name where 

there are two SID/TIC Servers but one is in redundant mode: 

 The primary SID/TIC Server has IP address is 10.45.212.100. 

 The redundant SID/TIC Server has IP address 10.45.212.101. 

1. Open the command prompt in administrator mode to view the encoding status. 

2. Run the following command on command prompt 

ContentCodeCmd -sid 9001 -input "C:\MPEGFILES\Unprocessed\test.mpg"-output 

C:\MPEGFILES\Processed\test.mpg --assetid "54321" -assetname 

"InterestingClip" –episode “Episode 1” –server “10.45.212.100” –server2 

“10.45.212.101” 

Note the following: 

 In Redundant Server Mode, the encoder switches between two SID/TIC Servers after 

every encoding session. 

 Do not use -server and -discover mask at the same time 

 If -server2 is provided then the encoder runs in Redundant Server Mode. If, 

however, the redundant SID/TIC Server uses DHCP, do no use -server2.  

 If -discovermask is provided as 255.255.255.255, do not specify the -server2 

option. 

 Do not specify -server2 as 255.255.255.255. 
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Decode 

You can decode using a graphical user interface (GUI) or a command line tool 

(ContentCodeCmd). 

Use GUI to Decode 

To verify that encoding occurred, and that TICs were inserted, decode the encoded file. 

1. Start the VOD Content Encoder application. 

2. On the Encoded Video tab, select the file to decode. 

 

Figure 19: Decoding 

3. Click Decode. The Decoding status dialog box appears and fills with the SID/TIC 

information. When the decoding process is complete, the dialog box displays a 

summary of the watermarks that were detected for each SID. 

 

Figure 20: Decoder Output 
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Use ContentCodeCmd to Decode 

You can also use ContentCodeCmd to decode Nielsen-encoded files. You can display 

the results on the screen or send them to a file. ContentCodeCmd reports the results in 

this format: 

<stream offset>, <SID>, <code type>, <audio PID>, <TIC/timestamp> 

The VOD Encoder package includes a batch file, DisplayCodes.bat, which includes a call 

to ContentCodeCmd.exe. You may adjust the command-line arguments in this .bat file to 

meet your requirements and then execute the .bat file to conduct a single decoding 

session. 

Table 5: Decoding Parameters 

Parameter Description 

Stream offset Offset from the beginning of the stream where the end of the Nielsen 

watermark is located. The <stream offset> is expressed as  

hours : minutes : seconds 

SID Nielsen source identifier 

Code type PC for program content or FD for final distributor. The VOD Content 

Encoder inserts PC watermarks. If the decoder reports FD watermarks, 

those watermarks were inserted by another Nielsen encoder. 

Audio PID MPEG PID that identifies the AC-3 stream in which the Nielsen watermark 

was found 

TIC/Timestamp Numeric value that identifies a specific segment of the encoded asset. 

Each 4-second segment of code has a unique TIC or timestamp. 

 

Table 6: Decoding Command Line Arguments 

Argument Description 

-decode Activity the tool should do 

-input Full path name of the file to be decoded 

Decoding Example 

This shows how to decode the file, C:\MPEGFILES\Processed\test.mpg, and store the 

report in the file, C:\Temp\decoder_out.txt, while displaying the report on the screen:  

1. Open the command prompt in administrator mode to view the decoding status. 

2. Run the following command on command prompt 

ContentCodeCmd –decode –input “C:\MPEGFILES\Processed\test.mpg” 
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Transfer Metadata Files to the Nielsen CF 

For crediting, your plant must transfer metadata files to the Nielsen CF. There are several 

ways to transfer the files: through the content encoder itself, using the File Transfer 

Manager application, or using the File Trigger Service to manually or automatically 

transfer the files. See also Appendix A: Workflows on page 70. 

 Transfer Files Using the VOD Content Encoder GUI (Workflow 1, 2, and 4): In the 

VOD Content Encoder application, from the File menu, select Transfer. All zip files in 

the Nielsen\metadata directory transfer to the CF or the Local Service, depending on 

your configuration. 

 Transfer Files Using the File Transfer Manager (Workflow 3 and 5): In the File 

Transfer Manager application installed on a separate computer, from the File menu, 

select Transfer. All zip files in the Nielsen\metadata directory transfer to the CF. 

 Transfer Files Using the File Transfer Service: File Transfer Service periodically 

monitors the metadata folder and transfers all the ZIP metadata present in the folder 

to the CF.  



 VOD Content Encoder User Manual 

 

 

Release 6.0 Revision J 40 Nielsen Confidential 

Maintain the Encoder 

Add New Distribution Source or SID 

Nielsen Encoder Support adds new distribution source identifiers (SIDs). The process 

includes deactivating the installed WRR, generating a backup WRR, and sending the 

backup to Nielsen. Nielsen updates the WRR and sends the updated WRR to you and 

you install it on the system. 

Important Facilities that use two active SID/TIC Servers must deactivate both the primary and redundant 

WRR and send both backup copies to Nielsen Encoder Support for modification. 

1. Contact the Nielsen Encoder Support, who will guide your through this procedure. 

See page 6 for contact information. 

2. Deactivate and backup the current WRR. See page 48 for deactivation procedure. 

3. If you have a redundant server, also deactivate the WRR on the redundant SID/TIC 

Server. 

4. Backup WRR file name has timestamp post-fixed in file name. In Windows Explorer, 

check the date of the file or files just created to ensure you are sending the correct 

WRR files to Encoder support 

5. Send the copy of the backup WRR for the host and, if any, the copy for the redundant 

SID/TIC Server to Nielsen Encoder Support. Nielsen sends the updated WRRs to 

you. 

6. For each, WRR, follow the process in “Upgrade WRR” on page 53. 

Add New Profile 

A profile contains the locations you specify for the video source files, encoded files, and 

ADI files plus the SID and DSID. 

When a WRR is upgraded with new SIDs, which are not on a previous SID/TIC Server, 

delete all existing profiles then configure a new profile.  

1. On the VOD Content Encoder application window, from the Configure menu, select 

Profile Setup. 
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Figure 21: Profile Editor Window 

2. Click Add. 

3. Enter a name for the profile. 

Note Once you assign a Profile Name, you cannot change it. To rename a profile, you would have to 

delete the profile and add a new one. 

4. Browse to the location for the video source(s). 

5. Browse to the location for the encoded file(s). 

6. (Optional) Browse to the location for the ADI file(s). 

7. Select a SID / Distribution Source. 

8. Click Apply. The window closes. 

Add or Extend Allocation of BOCs to SID or Update CSID  

Nielsen Encoder Support allocates BOCs and extends the existing BOC allocation for a 

particular SID. The process includes deactivating the installed WRR, generating a backup 

WRR, and sending the backup to Nielsen. Encoder Support updates the WRR and sends 

you the updated WRR for you to install it on the system. 

Important Facilities that use two active SID/TIC Servers must deactivate both the primary and redundant 

WRR and send both backup copies to Nielsen Encoder Support for modification. 

1. Contact the Nielsen Encoder Support, who will guide your through this procedure. 

See page 6 for contact information. 

2. For a system with a single SID/TIC Server (one WRR) or a system that also has a 

redundant SID/TIC Server (two WRRs), do the following for each WRR: 

a. Deactivate the WRR. See “Deactivate WRR on page 46. 

b. Backup WRR file name has timestamp post-fixed in file name In Windows 

Explorer, check the date each file was created to ensure you have the copy 

you just created. 
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c. Send the copy of the backup WRR for the host and, if any, redundant 

SID/TIC Server to Encoder Support. Nielsen sends the updated WRRs to 

you. 

d. For each, WRR, follow the process in “Upgrade WRR” on page 51. 

3. After WRR upgrade, on WRR installer verify that the number of BOC available in 

SID/TIC list. 

Configure the ServicesMonitorTool 

The ServicesMonitorTool runs in the background and an icon appears in the Windows 

taskbar. This application monitors services and can restart services when they are not 

running. By default, the tool generates an alert for transfer failures of metadata files to the 

CF. The ServicesMonitorTool is automatically installed with the VOD software installation 

and is configured to start automatically on system reboot. 

By default, the checkboxes are enabled to monitor the VOD File Transfer Service, VOD 

File Trigger Service, Discovery Service, and SID/TIC Server Service. The user can only 

enable monitoring of those services that are already installed on the system. 

1. To open the VOD ServicesMonitorTool, click its icon in the Windows taskbar.  

 

Figure 22: VOD ServicesMonitorTool Icon in Taskbar 

Note If the icon for the application does not appear in the taskbar, in the Start menu, select  Program 

Files->Nielsen > ServicesMonitorTool.exe. 

 

Figure 23: VODServicesMonitorTool 

2. To start or stop monitoring of the corresponding services, check or uncheck the 

services checkboxes. 
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Important Nielsen recommends that you keep the default for Turn Off Error Popup (unchecked). If you check 

this box, the system does not generate error popups for metadata file transfer failures to CF. 

3. To view VOD and transfer logs, click View Log. 

4. To save the configuration to a file and minimize the application to the taskbar, click 

Save. When you click Cancel, the tool reverts to the previous configuration and 

minimizes to the taskbar.  

5. To close the dialog box, click the X in the upper right corner. 

Deactivate Discovery Service 

Deactivate the Discovery Service, when only one SID/TIC Server is on the network or 

when using a cloud machine. 

Important Perform this step only if you do not want the SID/TIC Server on this computer to be “discovered” 

by VOD Content Encoders. 

1. In Control Panel (or equivalent), open Administrative Tools > Services. See #2 in 

Figure 37. 

2. Right-click Nielsen Discovery Service and select Properties. See Figure 24. 

3. To prevent the application from auto-starting during boot up, use the Properties 

option to change the Discovery Service on this machine from an Automatic Service to 

a Manual Service.  

4. Open the VOD ServicesMonitorTool from taskbar and uncheck the “Monitor 

Discovery Service” checkbox to disable the discovery services monitoring. 

 

Figure 24: Discovery Service Properties 
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Delete Profile 

1. On the VOD Content Encoder application window, from the Configure menu, select 

Profile Setup. 

2. In the Profile List, select the profile. 

3. Click Delete. A warning message appears. 

 

Figure 25: Delete Profile Warning Message 

4. Click OK. 

Important If you decide not to delete the profile, click Cancel rather than Apply on the Profile Editor window. 

5. Click Apply. The Profile Setup window closes. 

Edit Profile 

1. On the VOD Content Encoder application window, from the Configure menu, select 

Profile Setup. 

 

Figure 26: Profile Editor Window 

2. Click Edit. 

Note You cannot change the name of an existing profile. You have to delete the existing profile and 

create a new one. 

3. Browse to the location for the video source(s). 

4. Browse to the location for the encoded file(s). 
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5. (Optional) Browse to the location for the ADI file(s). 

6. Select a SID / Distrib Source. 

7. Click Apply. The window closes. 

Enable or Disable Clean Content Check 

When Clean Content Check is enabled, the Encoder does pre-encoding analysis of a 

stream and verifies that the content does not contain any pre-existing N2, NW, or CBET 

codes. If the Encoder detects pre-existing codes, encoding stops. This check only works 

for assets that are at least 180 seconds long. 

1. From the Start menu, start the VOD Content Encoder application. 

2. On the Configure menu, select Clean Content Check. 

 

Figure 27: Clean Content Check on the Configure Menu 

3. Contact the Nielsen Encoder Support, who will provide you with a user name and 

password.See page 6 for contact information. 

 

Figure 28: Configure Clean Content Check 

4. From the drop down list, select YES. 

5. Click Save. 
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Restart the SID/TIC Server 

For instructions on restarting the SID/TIC Server, see “Verify SID/TIC Server Is Running” 

on page 61. 

Maintain WRR 

Deactivate WRR 

Contact Nielsen Encoder Support (see page 6 for contact information). 

Important If the WRR is deactivated, the SID/TIC Server cannot serve encoding requests until the WRR is 

reinstalled. Contact the Nielsen Encoder Support before following the deactivating process and 

plan accordingly. See “Customer Support” on page 6. 

1. From the Start menu, start WRR Installer. 

2. On the menu bar, select Deactivate > Deactivate and Backup WRR. 

 

Figure 29: WRR Installer Application - Deactivate WRR 

3. On the warning popup message that appears, click Yes.   
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Figure 30: Deactivate WRR Warning 

4. Browse to the location for backup. 

 

Figure 31: Backup Folder 

5. To complete the backup and deactivate the WRR, click OK. 

Note If the WRR is already Inactive then Deactivate WRR only confirms that a backup is needed and 

performs a backup. 

Generate Unique Key for Host System 

A unique key should be generated on the system where the SID/TIC Server software is 

installed or where it will be installed. EVS creates a WRR (Watermark Resource Record) 

that is linked to the UniqueKey of the host system. The WRR can only be installed on one 

machine that has the key that matches the unique key in the WRR. 

1. From the Start menu, start WRR Installer. 
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2. Select Tools > GetUniqueKey. 

Figure 32: Menu Option to Create Text File (WRR) for Unique Key 

3. Browse to the folder where you want to store the key. 

 

Figure 33: UniqueKey Storage Location 

4. Click GenerateUniqueKey. The application generates the file, UniqueKey.txt, and 

saves it in the folder. 

5. Click OK. 

6. Send the UniqueKey.txt file to Nielsen Encoder Support. 

Important Do not modify the UniqueKey.txt file. 

Install WRR 

1. Do one of the following: 

 If have a WRR, go to the next step. 
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 If you do not have a WRR, request one from Nielsen Encoder Support for WRR. 

See also “Generate Unique Key for Host System” on page 47. 

2. From the Start menu, start the WRR Installer. 

3. Click Install WRR. 

 

Figure 34: WRR Installer Application – Install WRR 

4. To load the WRR file provided by Nielsen Encoder Support, on the Install WRR 

window, click Load WRR.  

 

Figure 35: Install WRR Window – Load and Install WRR 

5. Browse to the location of the WRR that Encoder Support sent to you and click Open. 

If a WRR is not available, follow the procedure, “Generate Unique Key for Host 

System” on page 47.  

6. Click Install. 
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7. Do one of the following: 

 If the installation was successful, the Install WRR dialog box closes. Go to the 

next step. 

 If an error occurred, contact Nielsen Encoder Support. 

8. Close the WRR installer. 

Remove WRR 

If the WRR cannot be installed or upgraded, contact Nielsen Encoder Support (see page 

6) who can provide you with a user name and password so that you can run the Remove 

WRR option. Otherwise, performing this function is not recommended because it 

removes the WRR database. 

1. From the Start menu, open WRR Installer. 

2. On the menu bar, select Repair > Remove WRR. 

3. Enter the user name and password. The WRR is removed from the system and the 

main window refreshes. 

Repair WRR 

If the WRR fails to load for any of the following reasons (see the status as shown in #1 in 

Figure 36), contact Nielsen Encoder Support who can provide you with a user name and 

password so that you can run the Repair WRR option. Otherwise, performing this 

function is not recommended. (For contact information, see 6.) 

 Corrupt WRR 

 Missing WRR 

 Invalid Primary WRR 

 Redundant WRR 

1. From the Start Menu, open WRR Installer. 

2. On the menu bar, select Repair > Repair WRR. 

3. Enter the user name and password. 

4. One of the following occurs: 

 The repair is successful and a confirmation message appears. Click OK 

 The WRR Repair fails. Contact Nielsen Encoder Support (see page 6). 

Set Automatic Backup Path for WRR 

The default path for automatic backups is C:\Nielsen\backup. On every successful 

encoding, the application creates a copy of the WRR copy and saves it to the backup 

folder. If the system fails, you can use this backup file to restore the WRR. Contact 

Nielsen Encoder Support for assistance with restoring from a backup file (see page 6). 



 VOD Content Encoder User Manual 

 

 

Release 6.0 Revision J 51 Nielsen Confidential 

1. From the Start menu, start WRR Installer. 

2. Select Configure > AutomaticBackupPath option. 

3. Select the new backup path and click OK. 

Important Do not set a password-protected network, mapped drive as the destination for saving an automatic 

backup of the WRR. 

Upgrade WRR 

1. From the Start menu, open WRR Installer. 

2. Verify the Installed host WRR loaded without errors (#1 in Figure 36). 

 

Figure 36: Upgrade WRR 

3. Do one of the following 

 If the WRR State is InActive (#2 in Figure 36), perform the procedure, 

“Deactivate WRR” on page 46 to create backup WRR and then go to step 4. 

 If the WRR state is Active, contact Nielsen Encoder Support and then follow 

the “Deactivate WRR” on page 46 to deactivate and create backup WRR. 

(For contact information, see page 6.) 

4. In Windows Explorer, browse to the location where backup WRR generated by 

deactivation process was saved. Verify the backup WRR name has the correct date 

and time stamp of when the backup was created. 

5. Send the backup WRR file to Nielsen Encoder Support. The team will send the 

updated WRR to you. 

6. In the WRR Installer dialog box, verify that the WRR State is Inactive.  
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7. Click Upgrade WRR (#3 in Figure 36). 

8. On the Upgrade WRR dialog box (Figure 37), click Load WRR. 

 

Figure 37: Load and Upgrade WRR 

9. Browse to the updated WRR file you received from Nielsen. 

10. Verify the WRR is loaded without errors. If any errors occurred, contact the Nielsen 

Encoder Support team (see page 6.). On the upgrade window, verify that request 

SID/DSID is added/updated and/or BOC is allocated/extended.  

If any issue occurs, contact the Nielsen Support team to get the WRR corrected. 

Repeat the upgrade procedure. 

11. To complete the upgrade, click Upgrade. If the upgrade is successful, the WRR 

Installer window refreshes with the latest Installed WRR as shown in Figure 38. 



 VOD Content Encoder User Manual 

 

 

Release 6.0 Revision J 53 Nielsen Confidential 

 

Figure 38: WRR Installer Application – After Upgrade WRR. 

12. To close the WRR installer application, click the X in the upper right corner. 
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Troubleshoot 

Encoder Services Are Not Running or Repeatedly Fail 

Important VOD Content Encoder applications should only be installed on systems used solely for Nielsen 

encoding. 

To permit the encoding software to run without interference, disable antivirus and firewall 

programs. If disabling is not possible, the security software must be configured to permit the files 

listed in the procedure below to run. 

Certain Internet security virus-protection applications may interfere with the VOD Content 

Encoder services and produce any or all of the following issues: 

 SID/TIC Discovery Server does not run or its function repeatedly fails. 

 SID/TIC Server Service does not run or its function repeatedly fails. 

 File Transfer Service does not run or its function does not automatically occur. 

 After successful installation of the VOD Content Encoder application, the 

VODFTMService.exe and/or VODFileTrigger.exe files disappear from the installation 

folder. 

 After successful installation of the SID/TIC Server application, the STSDiscovery.exe, 

and/or SIDTicService.exe files disappear from the installation folder. 

Note see the rest of this “Troubleshoot” section for other, potential causes) 

When these issues could be related to antivirus software, do the following: 

1. To see whether your antivirus software may be interfering with the encoding 

software, do the following: 

a. Open the history feature in the antivirus program. 

b. Examine the events for evidence of the encoder services stopping or failing. 

c. Add the following lines to the exclude or trust feature of your antivirus 

program. 

On a computer installed with... 

Trust or exclude this file in 

antivirus software: 

SID/TIC Server SIDTicService.exe and 

STSDiscovery.exe 

VOD Content Encoder VODFileTrigger.exe 

VODFTMService.exe 

File Transfer Manager VODFTMService.exe 

d. Reboot your system. 
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e. In Windows Control Panel (or equivalent), select Administrative Tools. 

2. Select Services and ensure that all of the following that apply to your system are 

operating correctly: 

 NIELSEN DISCOVERY SERVICE Status is Started. 

 NIELSEN FILE TRANSFER MANAGER SERVICE Status is Started. 

 NIELSEN SID TIC SERVER Status is Started. 

 NIELSEN VOD File Trigger Service Startup Type is Manual. 

 

Figure 39: Services Window 

3. If any services are missing, select All Programs and right-click 

RestoreNielsenServices. 

Note These steps apply to Windows 10. For Windows 7 or Windows Server, the steps may be slightly 

different. 

4. Select Run As Administrator: 

5. Ensure that the ServicesMonitorTool is running and monitor services checkbox is 

enabled to monitor the installed services. This tool automatically restarts a service 

that is not running.  

Issues with Nielsen VOD Content Encoder 

Error Loading Profiles 

 If you are running the VOD content encoder for first time then add new profiles. See 

“Add New Profile” on page 40. 

 If the profile configuration was deleted or missing, add the profiles again. See “Add 

New Profile” on page 40. 

 If the profile configuration is corrupted, create a new profile. See “Add New Profile” 

on page 40. 

 If you see the message, “Unable to establish connection with SID/TIC Server,” plus 

an error about loading the profile, you must first resolve a SID/TIC Server 

connectivity issue. See “Issues with SID/TIC Server” on page 59. 
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 If you see an issue with the SID/TIC Server and WRR plus an error regarding profile 

loading, resolve the WRR issue on the SID/TIC Server. See “Issues with WRR” on 

page 63. 

 Check the version number of the SID/TIC Server software. It must be 6.0 or greater. 

If it is not, upgrade the SID/TIC Server software. 

Issues with Encoding 

Use these steps to uncover root causes when encoding is not successful. 

BOC Issues 

If BOCs are depleting, no BOCs remain for SIDs, or a message that BOCs are not 

configured for the SID, contact Nielsen Encoder Support. Ask them to assign more BOCs 

for the SID in the WRR.  

To update the WRR with the new BOCs, perform the “Upgrade WRR” procedure on page 

51. 

Encoding Takes Too Long 

Ensure that other processes are not tying up the encoding system. Transferring large 

files to or from the Encoder host computer, for example, is very likely to slow down the 

encoding process. 

Error Getting DSID Name, Source, or DSID List from SID/TIC Server 

There is a connectivity issue with SID/TIC Server or the WRR on the SID/TIC Server. 

See “Issues with SID/TIC Server” on page 59. To resolve any WRR issues, see “Issues 

with WRR” on page 63. 

File Trigger Encoding Not Working 

XML trigger files should be placed in the Param folder that is configured in File Trigger 

Manager (Figure 10). 

 If the File Trigger Service is not processing the XML trigger file, ensure the path in 

File Trigger Manager is correct. 

 If XML trigger encoding fails and the XMLTriggerFile is marked as failed, look in the 

VodLog.txt file for error details. 
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Input File Duration Too Short 

When Clean Content Check is enabled, input content must be at least 180 seconds long. 

To encode shorter content, disable Clean Content Check. See “Enable or Disable Clean 

Content Check” on page 45. 

Invalid Commercial Encoding Request for VOD SID 

Commercial Encoding is not supported by the VOD Encoder application. Contact Nielsen 

Encoder support to provide the WRR without commercial SIDs, that is, DSID != 0. To 

update the WRR on the host system, perform the “Upgrade WRR” procedure on page 44. 

LOCTS CSID Linked with SID in WRR 

LOCTS CSID encoding is not supported. Contact Nielsen Encoder Support to provide the 

WRR without a LOCTS CSID. To update the WRR on the host system, perform the 

“Upgrade WRR” procedure on page 51. 

Missing Files on Encoded Video Tab 

1. An incorrect profile for this decoding session may have been selected. 

2. From the Configure menu on the home page of the Encoder application, select 

Profile Setup. See “Edit Profile” on page 44. 

3. Ensure that the encoded-file path specifies the full path name of the file that you just 

encoded.  

Missing MPEG Files on Source Video Tab 

It may be that the incorrect profile for this encoding session was selected or you may 

need to create a new profile with the correct video source path. 

1. From the Configure menu on the home page of the Encoder application, select 

Profile Setup. 

2. Do one of the following: 

 Ensure that the video source path specifies the location of the file that you would 

like to encode. See “Edit Profile” on page 44. 

 Create a new profile. See “Add New Profile” on page 40. 

Missing or Few Watermarks When File is Decoded 

If the content was difficult to encode (very quiet, for example) or if the AC-3 stream bit 

rate was too low, the Encoder may not have been able to insert as many audio codes as 

expected.  
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Ensure that audio levels are properly set at the broadcast facility. See the Nielsen 

Encoding Installation and Configuration Policy.  

Nielsen Unable to Detect Watermarks in Encoded File  

Ensure that audio levels are properly set at the broadcast facility. See the Encoding 

Installation and Configuration Policy.  

Ensure that you pitched the encoded file, not the original source file. 

Pre-Encoding Analysis Failed 

Ensure that the content to be encoded is clean, that is, the content has no pre-existing 

Nielsen Watermarks or CBET Watermarks. 

If you wish to stop the pre-encoding analysis, contact Nielsen Encoder Support. See also 

“Enable or Disable Clean Content Check” on page 45. 

Socket Connect, Send, or Receive Error During Encoding 

There is a connectivity issue with the SID/TIC Server. See “Issues with SID/TIC Server” 

on page 59. 

Unable to Create or Write to the Output File 

Ensure that the encoded path that you selected is not read-only.  

Unsupported Stream Type 

Content with AES3 audio streams or a mix of AES3 and AC3 audio streams is not 

supported. The Encoder only supports AC3 audio. 

https://engineeringportal.nielsen.com/w/downloads/tv/Encoding/Encoding_Installation_and_Configuration_Policy_Rev_G.pdf
https://engineeringportal.nielsen.com/w/downloads/tv/Encoding/Encoding_Installation_and_Configuration_Policy_Rev_G.pdf
https://engineeringportal.nielsen.com/w/downloads/tv/Encoding/Encoding_Installation_and_Configuration_Policy_Rev_G.pdf
https://engineeringportal.nielsen.com/w/downloads/tv/Encoding/Encoding_Installation_and_Configuration_Policy_Rev_G.pdf


 VOD Content Encoder User Manual 

 

 

Release 6.0 Revision J 59 Nielsen Confidential 

Issues with SID/TIC Server 

To start an encoding session, the Encoder must first establish a network connection to a 

properly configured, active SID/TIC Server. Even if the Server resides on the same 

computer as the Encoder, the Server and the Encoder application communicate using 

TCP/IP protocol. Communication issues may occur that prevent encoding from taking 

place.  

If you see an error message, “SID/TIC Request Failed” or “Unable to establish valid 

connection with SID/TIC Server,” use the following steps to look for root causes. 

Check Contents of WRR  

1. From the Start menu, open WRR Installer. 

 

Figure 40: WRR Installer Window 

2. In the section, SID/TIC Records on Host WRR, check that the information is correct. 

3. Do the expected SIDs and distribution source appear in the list?   

 If not, do most of the SIDs in the list appear to be valid? If SIDs are missing, 

perform the procedure, Add New Distribution Source or SID, on page 40. 

 If the entries appear, are they garbled or missing? If the WRR Installer window 

indicates that the WRR failed to load, perform the procedure, “Repair WRR,” on 

page 50. 
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Communications with Nielsen Fail 

Check your firewall to ensure it is not preventing communications between the Server 

and the Encoder. 

Communications with SID/TIC Server Fail 

1. To check whether the SID/TIC Server address is correct, on the VOD Content 

Encoder application window (Figure 7), select Configure > System Setup.  

2. If the address is valid, note the following to determine whether it is a subnet mask or 

a specific IP address: 

 If the address does not contain any 255 segments, the address is a specific IP 

address, which means the Encoder uses the “direct connection” method of 

connecting to the SID/TIC Server.  

 If the address is set to 255. 255. 255. 255, the address is a mask. Go to 

“Verifying the Discovery Server Is Running” on page 69. 

 

Figure 41: SID/TIC Server Address on Mask in the Encoder Configuration Window 

Run SID/TIC Server Test 

On the Configure menu in the VOD Content Encoder window, select SID/TIC Server 

Test. One of the following occurs: 

 A message appears, “Discovered an active SID/TIC Server at IP address 

xxx.xxx.xxx.xxx.” 

The Encoder is properly communicating with the SID/TIC Server. 

 A message appears, “Invalid response from SID/TIC Server at IP Address 

xxx.xxx.xxx.xxx.” 

It is likely that the IP address identifies a computer that has a SID/TIC Server on it, 

but that the SID/TIC Server is improperly configured. Recheck the SID/TIC Server 

setup at the specified address. 

 A message appears, “Unable to discover an active SID/TIC Server at 

xxx.xxx.xxx.xxx.”  

A properly configured SID/TIC Server is not running at the specified address. 

Recheck the IP address and the configuration of the software and SID/TIC Drive at 

that IP address. 
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Test Connection to SID/TIC Server 

1. Open a command line window. 

2. Type ipconfig and press Enter. 

3. Note the IP address. 

4. Do one of the following: 

 If the IP address in the command window matches the IP address in Figure 7: 

Encoder Configuration (System Setup) Window, see the next section, “Run 

SID/TIC Server Test.” 

 If the addresses do not match, enter the correct address or mask into the 

SID/TIC Server IP Address or Mask field in Figure 7: Encoder Configuration 

(System Setup) Window. 

Verify Discovery Server Is Running 

Use the procedure above for verifying the SID/TIC Server is running, except check that 

the Discovery Service is running (#2 in Figure 42). 

Note This step only applies if you rely on the discovery method of identifying a SID/TIC Server. The 

Discovery Server should be running ONLY if you supply a subnet mask instead of a SID/TIC 

Server IP address on the Encoder Configuration window of the Encoder application. Discovery 

Service functionality is not supported in workflows that include cloud interactions. For a 

workaround, contact Encoder Support. See page 6.Workflows that configures VOD to discover 

SID/TIC server on network needs VOD Content Encoder and SID/TIC server to be installed on the 

same network subnet. 

Verify Installation of WRR  

1. From the Start menu, open WRR Installer. 

2. Verify the Host WRR Load is successful. 

3. Verify the HOST WRR state is Active. 

4. If WRR shows as InActive, contact Nielsen Encoder Support (see page 6). Follow the 

procedures in “Deactivate WRR on page 46. See also “Upgrade WRR” on page 51. 

Verify SID/TIC Server Is Running 

1. In Windows Control Panel (or equivalent), select Administrative Tools. 

2. Select Services (#1 in Figure 42). 

3. Check that the Status column shows the server is Started and the Startup Type is 

Automatic. See Figure 43. 
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Figure 42: Services Window 

4. Do one of the following: 

 If the settings are correct, go to “Verify Discovery Server Is Running” on page 

61. 

 If the settings are not correct, right-click the same line and select Properties 

and go to the next step. 

5. In the Trigger Service status section on the General tab, select Start. See Figure 43. 

6. To set the Server to automatically start, in the Startup type field, select Automatic. 

7. Click OK. 

 

Figure 43: Services Properties Window 

Unknown Request Code or Truncated Response from WRR 

Ensure that the SID/TIC Server version is 6.0 or later. Contact Nielsen Encoder Support 

for assistance. 
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Issues with Installation and Upgrade 

Note For information on contacting Nielsen Encoder Support, see page 6. 

Issues with WRR 

WRR Installation Failures 

Table 7: WRR Installation Failure Reasons 

If you receive a message that… Because… Do this: 

 WRR is invalid. 

 WRR is corrupt. 

 WRR has an invalid 

state. 

 Contact Nielsen Encoder Support 

to get a new WRR. 

Note Only install a WRR that 

Encoder support provides. Do 

not try to install or copy a 

backup WRR or a WRR with 

an Inactive state. 

Selected WRR cannot be 

installed. WRR license 

validation failed. 

You are trying to install the 

WRR on a different system 

then the system for which 

Nielsen Encoder Support 

created it.  

Use the WRR file that Nielsen 

provided and install the WRR on 

the correct system. See page 6. 

Selected WRR cannot be 

installed. WRR Installation 

validity has expired. 

The expiry term for 

installing the WRR file has 

ended. 

Ask Nielsen Encoder Support to 

extend the installation validity. 

See page 6. 

To upgrade the WRR, follow the 

procedure on page 51. 

WRR is already installed. The Install WRR button on 

the WRR Installer dialog 

box (Figure 3) is only for 

fresh installations. 

1. Open the WRR Installer. 

2. Perform the “Upgrade WRR” 

procedure on page 51. 
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WRR Upgrade Failures 

Table 8: WRR Upgrade Failure Reasons 

If you receive a message that the upgrade 

failed because… Do this: 

Host WRR is active Perform the “Upgrade WRR” procedure on 

page 51. 

Version of WRR for upgrade is older than 

installed WRR 

Ensure that you are installing the latest 

upgraded WRR provided by Encoder 

Support. For help, see page 6. 

The version of the WRR for upgrade has 

older nextAvaibleTic values than installed 

host WRR. 

Ensure that you install the latest WRR 

provided by Encoder Support. For help, see 

page 6. 

WRR is not installed. Perform the install procedure on page 48. 

 Host WRR is corrupt. 

 Host WRR is Invalid. 

 Host WRR is NotInSync. 

Contact Nielsen Encoder support for WRR 

repair. If the repair fails, remove the WRR 

(page 50) and do a fresh installation (page 

48). 

 WRR for upgrade is corrupt. 

 WRR has an invalid state. 

 WRR is invalid. 

Request a new WRR from Contact Nielsen 

encoder support for new WRR 

 Selected WRR cannot be upgraded. 

 WRR license validation failed. 

Use the UniqueKey.txt file to install or 

upgrade the WRR on the system for which 

Encoder Support provided it. For assistance, 

contact Encoder Support. See page 6. 

Selected WRR cannot be upgraded. WRR 

Installation validity has expired. 

Ask Nielsen Encoder Support to extend the 

installation validity of the WRR. See page 6.  

Serial Number mismatch Contact Nielsen Encoder Support to verify 

that you are upgrading to the latest WRR 

that they provided. See page 6. 

To remove the old, and now invalid, WRR, 

follow the procedure on page 50. 

Redundancy status mismatch Ensure that the upgraded WRR redundancy 

status matches the Host WRR redundancy 

status. When two redundant WRRs are on a 

network, ensure you install the WRR on the 

correct SID/TIC Server system. 
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WRR Issues During Encoding or Loading of Profiles 

Table 9: WRR Issues During Encoding or Loading of Profiles 

If you receive a message that 

encoding failed because… Do this: 

Host WRR is not active Perform the “Upgrade WRR” procedure on page 51. 

 WRR needs repair. 

 WRR is NotInSync. 

 Contact Nielsen Encoder support for WRR repair. 

If the repair fails, remove the WRR (page 50) and 

do a fresh installation (page 48). 

 Check the version of the SID/TIC Server and 

ensure that the version is 6.0 or greater. 

WRR is corrupt. Contact Nielsen Encoder Support to remove the 

corrupt WRR (page 50) and install a fresh WRR 

copy from backup (page 48). 

 BOCs are depleting. 

 No BOCs are configured. 

 No BOCs remain. 

Contact Nielsen Encoder Support to add BOCs to 

the SID. Follow upgrade procedure to add BOCs to 

Host WRR (page 41). 

LOCTS CSID not supported. Contact Nielsen Encoder Support to remove the 

unsupported LOCTS CSID. 

 CSID is not linked to SID 

 CSID value was not found. 

Contact Nielsen Encoder Support for new a WRR. 

See page 6. 

 SID/TIC record was not found. 

 Authentication failed. 

 Ensure that the SIDs configured on the WRR are 

used for encoding. 

 Check that the TIC is available for encoding for 

the selected SID. 

TICs are depleting. Contact Nielsen Encoder Support to upgrade the 

host WRR. See page 6. 
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Issues with Metadata Transfer 

The VOD Content Encoder File Transfer Service periodically transfers any available feed-

point metadata files to the Nielsen CF. Follow these steps when metadata files have not 

properly transferred. 

Verify File Transfer Service Is Correctly Operating 

1. In the VOD Content Encoder application, select View > Log File. 

2. Scroll through the log file, searching for any of the following messages. 

 This message indicates that a file was successfully transferred to the CF at the 

time that the message was sent. 

Successfully transferred file xxx_yyy_adi.xml (where xxx is the SID and yyy is the first TIC). 

 This message indicates that no files have been transferred since the last 

message from the File Transfer Manager. In the absence of other more specific 

error messages, however, this is not an error report. Instead, it merely indicates 

that there were no feed-point metadata files ready to be transferred. 

FTM: Transferred 0 files. 

An error message in the error log or no reports from the File Transfer Manager over a 

long period indicates File Transfer Service may not be properly functioning. See the 

next section, “Verify File Transfer Manager Service Is Running.” 

Verify File Transfer Manager Service Is Running 

1. To ensure that the File Transfer Manager Service is running, from the Start menu, 

select Control Panel > Administrative Tools > Services (Figure 37).  

 

Figure 44: Services Windows 

2. From the list of services, look for Nielsen File Transfer Manager Service and do one 

of the following: 
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 If the File Transfer Manager Service does not appear in the list, the Encoder 

software was not properly installed. Uninstall and reinstall the VOD Content 

Encoder software. 

 If the File Transfer Manager Service DOES appear in the list, check the status of 

the Trigger Service. If the status is not Started, right-click on the File Transfer 

Manager Service list entry and select Start. 

3. From the View menu on the menu bar in the VOD Content Encoder window (Figure 

45), select Configure > System Setup. Check the settings against those in Table 4: 

Feed Point Transfer Parameters on page 27.Table 3 

 

Figure 45: VOD Content Encoder Application GUI Window 

4. Click Save. 

5. On the File menu in the VOD Content Encoder window, select Transfer. If all 

components are properly configured, all files should transfer from the metadata folder 

to the CF and the original files to the arch_metadata folder. A message should 

confirm that the transfer was successful. If the transfer fails, do the following: 

6. Check the network configuration and firewall settings on the Encoder. 

7. Verify that a third party FTP application is not running on the same subnet as the File 

Transfer Service by doing the following: 

8. In Control Panel (or equivalent), open Administrative Tools > Services (Figure 37). 

9. Examine the list to see if an FTP application other than the Nielsen File Transfer 

Manager Service is running. 

10. To prevent a conflicting FTP application from auto-starting during boot up, use the 

Properties option to change the FTP service from an Automatic Service to a Disabled 

Service. 

Note If File Transfer Manager Service problems persist, call Nielsen Encoder Support to check the 

status of the metadata server at the CF. See “Customer Support” on page 6. 
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VodLog.txt Shows Repeated “Failed OpenService(), lastErr = 1060l” Messages 

To correct this error, use the VODServicesMonitor Tool (Figure 46) to disable the services 

shown in Table 10. See also, “Appendix A: Workflows” on page 70. 

Table 10: Disable Monitoring of Unused Services 

If… 

In the VODServicesMonitor Tool, do 

this: Applies To 

VOD Content Encoder and 

SID/TIC Server are installed on 

different machines  

On the Encoder machine, disable 

monitoring of 

 SID/TIC Service 

 Discovery Service 

Workflow 2 

Workflow 4 

Workflow 5 

SID/TIC Server is installed on 

a machine without the Encoder 

and File Transfer Service 

On the SID/TIC Server machine, 

disable monitoring of 

 File Transfer Service 

 File Trigger Service 

Workflow 2 

Workflow 3 

Workflow 4 

Workflow 5 

The file transfer machine is 

installed without the Encoder 

or SID/TIC Server 

On the file transfer machine, disable 

monitoring of 

 SID/TIC Server 

 Discovery Service 

 File Trigger Service 

Workflow 3 

Workflow 5 

 

Figure 46: VODServicesMonitorTool 
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Issues with WRR Running on AWS EC2 Instances 

The following are known issues with WRRs running on AWS EC2 instances: 

 Rebooting (planned / unplanned) Instance – valid use case  

 Stop and Start Instance  – valid use case 

 Change of instance type e.g., x2Large to t2 micro – valid scenario 

 Create system image (AMI) and launch new instance creation – invalid use case 

 Creating Dedicated Instance and rebooting – valid scenario 

 Creating the snapshot and creating the image – invalid scenario 

In some of the above scenarios, the WRR reported a failure due to a change to the 

underlying environment controlled by AWS. If any of these WRR issues occur, contact 

Nielsen Encoder Support for assistance. See page 6. 
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Appendix A: Workflows 

These workflows show the different configurations you can use to set up the Encoder, 

SID/TIC Server, and File Transfer Manager on one, two, or three computers. 

Workflow 1: One Computer Provides SID/TICs, Encodes, and Transfers Files 

Figure 47 shows a setup where a single computer performs all three functions. 

 

Figure 47:  Workflow 1—One Computer Performs Three Functions 

Table 11: Encoder Configuration Window Parameters for Workflow 1 

Parameters Settings (Figure 7) 

SID/TIC Server Address One of the following: 

 IP address of the computer 

 LoopBack IP 127.0.0.1 

 255.255.255.255, if your SID/TIC 

Server site uses DHCP 

Discovery Port Default 

SID/TIC Server Address 2 Does not apply 

Redundant Mode Disabled 

Feed-Point Transfer Parameters Defaults 
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Workflow 2: One Computer Provides SID/TICs and Another Encodes and 
Transfer Files 

 

Figure 48: Workflow 2—One Computer Provides SID/TICs and Another Computer Encodes and 

Transfers Files 

Table 12: Encoder Configuration Window Parameters for Workflow 2 

Parameters Settings for Computer 2 (Figure 7) 

SID/TIC Server Address One of the following: 

 IP address for Computer 1 

 255.255.255.255, if Computer 1 

uses DHCP 

Note SID/TIC Server must have static IP 

address 

Discovery Port Default 

SID/TIC Server Address 2 Does not apply 

Redundant Mode Disabled 

Feed-Point Transfer Parameters Defaults 
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Workflow 3: One Computer Provides SID/TICs and Encodes and Second 
Computer Transfer Files 

 

Figure 49: Workflow 3—One Computer Provides SID/TICS and Encodes and Another Transfers Files 

Table 13: Encoder Configuration Window Parameters for Workflow 3 

Parameters Settings for Computer 1 (Figure 7) 

Settings for 

Computer 2 (Figure 7) 

SID/TIC Server 

Address 

One of the following: 

 IP address of SID/TIC Server 

 255.255.255.255, if your 

SID/TIC Server site uses DHCP 

Default 

Discovery Port Default Default 

SID/TIC Server 

Address 2 

Does not apply Default 

Redundant Mode Disabled Default 

Feed-Point Transfer 

Parameters 

Communications parameters for 

Computer 2 

Defaults 
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Workflow 4: Two Computers Provide SID/TICs and Third Computer Encodes 
and Transfers Files (Discovery Service or Redundant Mode) 

 

Figure 50: Workflow 4—Two Computers Provide SID/TICs and Third Encodes and Transfers Files 

In this workflow where two computers provide SID/TICs and a third computer both 

encodes and transfers files to the CF, there are two configuration options: Discovery 

Mode (Table 14) and Redundant Mode (Table 15). 

Note In a cloud environment, the discovery mode configuration is not supported. Configure with the 

redundant server mode. The SID/TIC Server must have a static IP address. 

Table 14: Encoder Configuration Window Parameters for Workflow 4 in Discovery Mode 

Parameters Computer 3 in Discovery Mode (Figure 7) 

SID/TIC Server Address or Mask 255.255.255.255 

Discovery Port Default 

SID/TIC Server Address 2 Does not apply 

Redundant Mode Disabled 

Feed-Point Transfer Parameters Defaults 

 

Set Feed-Point Transfer Parameters to defaults. 

Table 15: Encoder Configuration Window Parameters for Workflow 4 in Redundant Mode 

Parameters Computer 3 in Redundant Mode (Figure 7) 

SID/TIC Server Address IP address of SID/TIC Server on computer 1 

Note SID/TIC Server must have static IP address 

Discovery Port Default 

SID/TIC Server Address 2 IP address of SID/TIC Server on computer 2 

Redundant Mode Enabled 
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Parameters Computer 3 in Redundant Mode (Figure 7) 

Feed-Point Transfer Parameters Defaults 

 

Workflow 5: One Computer Provides SID/TICs, Second Computer Encodes, and 
Third Computer Transfers Files 

Figure 51 shows the workflow when your plant uses three computers: one provides the 

SID/TICs, one encodes, and the third computer uses a third-party FTP application or the 

VOD Content Encoder software FTP client to transfer files to the Nielsen CF. 

 

Figure 51: Workflow 5—Three Computers Perform One Function Each 

Table 16: Encoder Configuration Window Parameters Workflow 5 

Parameters Settings for Computer 2 (Encoder) 

SID/TIC Server Address IP address of Computer 1 

Discovery Port Default 

SID/TIC Server Address 2 Does not apply 

Redundant Mode Disabled 

Feed-Point Transfer Use communications parameters for 

Computer 3 (the default values) 
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Appendix B: Contents of XML Files 

Contents of an XML Trigger File 

Standard XML File Parameters 

Table 17: Parameters Defined for Standard XML File-Encoding 

XML Label 

Parameter 

Data Type Parameter Usage 

InputFile char * Full path name of the source video file 

OutputFile char * Full path name of the encoded video file that the 

File-Trigger encoder creates 

AdiFile char * (Optional) full path name of the folder that holds 

CableLabs ADI (Asset Distribution Interface) . 

files 

SID Int The SID to be used in the upcoming encoding 

session 

AssetId char * The asset ID to be reported in the metadata file 

for the clip that is about to be encoded ( max 

supported length for AssetId is 20 characters ) 

AssetName char * The asset name to be reported in the metadata 

file for the clip that is about to be encoded ( max 

supported len for Assetname is 50 characters) 

EpisodeId char * The optional episode ID to be written to the 

feed-point metadata file( max supported len for 

EpisodeId is 20 characters) 

 

An XML file whose appearance in a specific folder triggers the start of a VOD-content 

encode. The path where these trigger files are located is identified by the 

"EncoderParamFolder" setting in the EncoderConfig.txt file 

The following is an example of a Sample-File-Trigger.xml file that includes clusters. 

<ContentEncodingParams> 

 <InputFile>   

  C:\temp\VoD\Source\Sample.mpg   

 </InputFile> 

 <OutputFile>  

  C:\temp\VoD\Encoded\Sample-enc.mpg  

 </OutputFile> 

 <SID> 
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  9000  

 </SID> 

 <AssetId> 

  Test ID 1 

 </AssetId> 

 <AssetName> 

  This is for File Trigger Encode Test. 

 </AssetName> 

</ContentEncodingParams> 

 Contents of an ADI File Trigger XML File 

The following is an example of a Sample-ADI-File-Trigger.xml file. For definitions of the 

parameters, see Table 17: Parameters Defined for Standard XML File-Encoding on page 

75. 

<ContentEncodingParams> 

 <InputFile> 

  C:\temp\VoD\Source\Sample.mpg 

 </InputFile>  

  <OutputFile> 

  C:\temp\VoD\Encoded\Sample-enc.mpg 

 </OutputFile>  

  <AdiFile> 

  C:\temp\VoD\ADI\Sample-ADI.XML 

 </AdiFile>  

  <SID> 

  9000 

 </SID>  

  <AssetId> 

  TEST0001137522386093 

 </AssetId>  

  <AssetName> 

  TEST24S04E01_Title 

 </AssetName>  

</ContentEncodingParams> 
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Glossary 

A 

ADIFileName 

The name of the CableLabs file (if any) that is transferred to the Nielsen Collection Facility along with the feed-point 

metadata file. 

AssetId 

The ID of the encoded content. May be derived from an Asset ID field in the CableLabs file. 

AssetName 

The name of the encoded content. May be derived from an Asset Name field in the CableLabs file. 

B 

BOC 

Billions of Codes. BOCIt is designed for content identification of both VOD ( Video -on -demand ) and commercials. 

Also, called Layer 4.  

C 

CF 

Nielsen Collection Facility. 

CBET 

Critical Band Encoding Technology 

CSID 

CBET source ID. CSID is prefixed by layer identification number, i.e., 1 to 5. CSID will be encoded with VOD SID if 

the WRR has CSID associated with SID. 

D 

Decoder 

An application that processes an audio stream (PCM or AC-3) and reports on the Nielsen watermarks (NAES II, NW, 

or both) that it finds in the audio stream. 

E 

Ending TIC 

The value of the last TIC reserved for this asset. 
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F 

FD 

Final Distributor. An attribute in watermark that identifies the watermark as inserted by a distributor. 

FileSizeBytes 

The size of the encoded file in bytes. 

FileSizeSeconds 

The approximate duration (in seconds) of the encoded file. This is just an approximation. For very long files, the 

estimated size may be incorrect by several seconds. 

L 

LOCTS 

Local Radio identification layer. Also called CBET layer 1. Not supported by VOD. 

N 

NAES II (Nielsen Audio Encoding System II) 

Also known as NAES II. The second-generation method of inserting a SID (Nielsen source identifier) and time stamp 

into a TV signal. 

NW (Nielsen Watermarks) 

A Nielsen technology that places an audio watermark in a lower-frequency portion of the active program than does 

NAES II technology. Its lower-frequency position enables NW to be more robust and much less likely to be 

“compressed out” of the program audio by TV distribution providers without interfering with the viewer’s listening 

experience. Unlike NAES II, however, NW code cannot be overwritten by successive program distributors. 

NETTS 

Network identification layer. Also called CBET layer 2. 

P 

PC (Program Content) 

An attribute in a watermark that identifies the watermark as inserted by a programming source. 

S 

Scratch Folder 

The Scratch folder must be an empty folder. TAR file processing is no longer supported. The presence of this file is 

only for configuration purposes.. 

SID (Source Identifier) 

Unique identifier that Nielsen assigns to each subscriber (or distribution source) using audio watermarking. Included 

as a component of each watermark, the SID uniquely identifies the distribution source. A subscriber may have more 

than one SID. 
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StartingTIC 

The value of the first TIC reserved and the first TIC inserted into this asset. 

T 

TIC (Time in Code) 

A time code used for encoding offline content. See Time Stamp. 

Time Code 

See Time Stamp. 

Time Stamp  

A component of the watermark that identifies one of two attributes: 

 A numeric representation of the date and time at which the watermark was inserted in 

the stream (referred to as a timestamp or time code, and typically used when 

streaming content is watermarked as it is being broadcast). 

 A numeric representation of the time-in-content (referred to as a TIC, and typically 

used when watermarking audio content that is stored in a file). By subtracting the 

starting TIC from the TIC extracted from the watermark, one can determine how 

many seconds into the stored file the watermark is located. 

In NAES II watermarking, the timestamp or TIC is represented as a 32-bit unsigned integer. The timestamp in Nielsen 

watermarking uses only 29 bits. 

Trigger File 

An XML file the presence of which in a specific folder triggers the start of a VOD content encode. The path where 

these trigger files are located is identified by the “EncoderParamFolder” setting in the EncoderConfig.txt file in the 

VOD ROOT / etc folder. 

TVLOC 

Local TV identification layer. Also called CBET Layer 5 

.W. 

Watermark 

Used as a noun, also referred to as an audio code, a watermark is a sequence of bits that the Nielsen Watermark 

software inserts periodically in an audio stream. The components of the watermark (SID, timestamp or TIC, and a PC 

or FD flag to identify the point of entry into the flow of content distribution). With these components, a watermark can 

uniquely identify the portion of audio from which the watermark is extracted, that is, the distribution source to which 

the audio content can be credited.  

Used as a verb, the term “to watermark” means to insert Nielsen codes into an audio stream. 

WRR 

Watermark Resource Record. An encryped file that is preconfigured with client-specific SID/TIC, CBET and BOC 

information. 
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